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FATEK Automation Corporation 

FB Series 

Computer Link Driver 
 Supported version TOP Design Studio V1.0 or higher  

 

CONTENTS 

We would like to thank our customers for using M2I's "Touch 

Operation Panel (M2I TOP) Series". Read this manual and familiarize 

yourself with the connection method and procedures of the “TOP and 

external device”. 

 

1. System configuration Page 2 

 

 

Describes the devices required for connection, the setting of 

each device, cables, and configurable systems. 

2. External device selection  Page 4 

 Select a TOP model and an external device. 

3. TOP communication setting Page 5 

 Describes how to set the TOP communication. 

4. External device setting Page 10 

 Describes how to set up communication for external devices. 

5. Cable table Page 11 

 Describes the cable specifications required for connection. 

6. Supported addresses Page 14 

 Refer to this section to check the addresses which can 

communicate with an external device. 
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1. System configuration 

The system configuration of TOP and “FATEK Automation Corporation – FB Series Computer Link” is as follows. 
 

Series CPU Link I/F 
Communication 

method 
System setting Cable 

FBs 

FBs-□□MA/MC 

FBs-□□MN 

 

Port 0 on CPU Unit RS-232C 

3. TOP communication 

setting 

4. External device 

setting 

5.1. Cable table 1 

FBs-CB2 

RS-232C 

3. TOP communication 

setting 

4. External device 

setting 

5.2. Cable table 2 
FBs-CB22 

(Port 1) 

FBs-CB25 

(port 1) 

FBs-CB25 

(port 2) 

RS-485 (2 Wire) 

3. TOP communication 

setting 

4. External device 

setting 

5.5 Cable table 5 FBs-CB5 

FBs-CB55 

FBs-CM22 

RS-232C 

3. TOP communication 

setting 

4. External device 

setting 

5.3. Cable table 3 
FBs-CM25 

(Port 3) 

FBs-CM25 

(Port 4) 
RS-485 (2 Wire) 

3. TOP communication 

setting 

4. External device 

setting 

5.5 Cable table 5 

FBs-CM25E 

(Port 3) 
RS-232C 

3. TOP communication 

setting 

4. External device 

setting 

5.3. Cable table 3 

FBs-CM25E 

(Port 4) 

RS-485 (2 Wire) 

3. TOP communication 

setting 

4. External device 

setting 

5.5 Cable table 5 FBs-CM55 

FBs-CM55E 

FBe 

FBn 

FBe–□□MA Port 0 on CPU Unit 

RS-232C 

3. TOP communication 

setting 

4. External device 

setting 

5.3. Cable table 3 

RS-485 (2 Wire) 

3. TOP communication 

setting 

4. External device 

setting 

5.5 Cable table 5 

FBe–□□MC 

FBn–□□MCT 
Port 0 on CPU Unit 

RS-232C 

3. TOP communication 

setting 

4. External device 

setting 

5.3. Cable table 3 

RS-485 (2 Wire) 

3. TOP communication 

setting 

4. External device 

setting 

5.5 Cable table 5 
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Series CPU Link I/F 
Communication 

method 
System setting Cable 

Port 1 on CPU Unit RS-232C 

3. TOP communication 

setting 

4. External device 

setting 
5.4 Cable table 4 

Port 2 on CPU Unit RS-485 (2 Wire) 

3. TOP communication 

setting 

4. External device 

setting 

FB-DTBR 

(Port 0) 
RS-232C 

3. TOP communication 

setting 

4. External device 

setting 

5.3. Cable table 3 

FB-DTBR 

(Port 1) 
RS-232C 

3. TOP communication 

setting 

4. External device 

setting 

5.2. Cable table 2 

FB-DTBR 

(Port 2) 
RS-485 (2 Wire) 

3. TOP communication 

setting 

4. External device 

setting 

5.5 Cable table 5 

FB-DTBR–E 

(Port 0) 
RS-232C 

3. TOP communication 

setting 

4. External device 

setting 

5.3. Cable table 3 

FB-DTBR–E 

(Port 2) 
RS-485 (2 Wire) 

3. TOP communication 

setting 

4. External device 

setting 

5.5 Cable table 5 
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■ Connection configuration 

 

ㆍ1:1 (one TOP and one external device) connection – configuration which is possible in RS232C/422 communication. 

 
 

ㆍ1:N (one TOP and multiple external devices) connection – configuration which is possible in RS422 communication. 
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 
 

 

 
 

 
 

 

Settings Contents 

TOP Model Check the TOP display and process to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Select “FATEK Automation Corporation”. 

PLC Select an external device to connect to TOP. 
 

Model Interface Protocol 

FB Series Computer Link Serial 
 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [ Project > Project properties > TOP settings] → [Project option > Check “Use HMI settings” > Edit > Serial ] 

– Set the TOP communication interface in TOP Design Studio. 
 

 

 

 
 

Items TOP External device Remarks 

Signal Level (port) 
RS-232C RS-485 

RS-232C 

RS-485 
 

Baud Rate 9600  

Data Bit 7  

Stop Bit 1  

Parity Bit Even  

* The above settings are examples recommended by the company. 

 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device. 

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [ Project > Project properties > PLC setting > COM1 > “PLC1: FB Series”] 

– Set the options of the communication driver of FATEK Automation Corporation – FB Series Computer Link in TOP Design 

Studio. 

 

 

Items Settings Remarks 

Interface Select “Computer Link”. Refer to “2. External 

device selection”. Protocol Select “Serial”. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external 

device and sending the next command request. 
 

Station No  Enter the prefix of an external device.  

※ If you use external device prefix 0, all devices on the connected track will respond. Use the designated prefix from 1 to 254 to operate only the 

relevant number.
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3.2. Communication setting in TOP  

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

   

(1) Communication interface setting 

■ [ Main screen > Control panel > Serial ] 
 

 

Items TOP External device Remarks 

Signal Level (port) 
RS-232C RS-485 

RS-232C 

RS-485 
 

Baud Rate 9600  

Data Bit 7  

Stop Bit 1  

Parity Bit Even  

* The above settings are setting examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device. 

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [ Main screen > Control panel > PLC ] 
 

 

Items Settings Remarks 

Interface Select “Computer Link”. Refer to “2. External 

device selection”. Protocol Select “Serial”. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external 

device and sending the next command request. 
 

Station No Enter the prefix of an external device.  

※ If you use external device prefix 0, all devices on the connected track will respond. Use the designated prefix from 1 to 254 to operate only the 

relevant number. 
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check whether the port (COM1/COM2/COM3) settings you want to use are the same as those of the external device in [Control 

panel > Serial]. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch “Communication diagnostics” in [Control Panel > PLC ]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

External device CPU name OK NG 

4. External device setting 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

Check address range  

OK NG 

6. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. External device setting 
 

Use “FB Series” Ladder Software “WinProladder” to set as follows. After downloading the settings, reboot the power of the external 

device. 

For more detailed setting method than that described in this example, refer to the PLC user manual. 
 

■ When using Port 0 

The serial parameters of the corresponding port is fixed as the target setting value of TOP communication setting example. (9600bps 

/ 7bit / 1bit / Even parity) 

 

■ When using Port 1 

1. Select the “[Setting] – [Port 1 Parameter]” route in the PLC menu of “Ladder Software “WinProladder” to display the [Comm. 

Parameter Setting] Dialog box. 

2. Set as follows in the [Comm. Parameter Setting] Dialog box. 

Items Settings Remarks 

Communication speed 9600 bps  

Data Bit 7 bit  

Stop Bit 1 bit  

Parity Bit Even  

 

■ When using Port 2 

1. Select the “[Setting] – [Port 2 Parameter]” route in the PLC menu of “Ladder Software “WinProladder” to display the [Comm. 

Parameter Setting] Dialog box. 

2. Set as follows in the [Comm. Parameter Setting] Dialog box. 

Items Settings Remarks 

Communication speed 9600 bps  

Data Bit 7 bit  

Stop Bit 1 bit  

Parity Bit Even  

 

■ When using Port 3 

1. Select the “[Setting] – [Port 3 Parameter]” route in the PLC menu of “Ladder Software “WinProladder” to display the [Comm. 

Parameter Setting] Dialog box. 

2. Set as follows in the [Comm. Parameter Setting] Dialog box. 

Items Settings Remarks 

Communication speed 9600 bps  

Data Bit 7 bit  

Stop Bit 1 bit  

Parity Bit Even  

 

■ When using Port 4 

1. Select the “[Setting] – [Port 4 Parameter]” route in the PLC menu of “Ladder Software “WinProladder” to display the [Comm. 

Parameter Setting] Dialog box. 

2. Set as follows in the [Comm. Parameter Setting] Dialog box. 

Items Settings Remarks 

Communication speed 9600 bps  

Data Bit 7 bit  

Stop Bit 1 bit  

Parity Bit Even  
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5. Cable table 

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device. 

(The cable diagram described in this section may differ from the recommendations of “FATEK Automation Corporation”) 
 

5.1 Cable table 1 (FBs Series - Port 0 on CPU Unit) 
 

 
It is recommended to use a cable dedicated to FBs-232P0-9F-150 (FATEK Automation 

Corporation Port0. 

■ RS-232C (1:1 connection) 

COM1 / COM2 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 GND 

 

Based on 

communication 

cable connector 

front, 

D-SUB 4 Pin male 

(male, convex) 

RD 2 2 RXD 

SD 3 3 ––– 

DTR 4 4 TXD 

SG 5   

DSR 6   

RTS 7   

CTS 8   

 
9  

 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

5.2 Cable table 2 (FBs-CB2, FBs-CB22(Port1), FBs-CB25(Port1), FB-DTBR(Port1)) 
 

■ RS-232C (1:1 connection) 

COM1 / COM2 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 CD 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RD 2 2 TXD 

SD 3 3 RXD 

DTR 4 4 DTR 

SG 5 5 SG 

DSR 6 6 DSR 

RTS 7 7 RTS 

CTS 8 8 CTS 

 9 9  

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

5.3 Cable table 3 (FBs-CM22, FBs-CM25(Port3), FBe/FBn – Port 0 on CPU Unit, FB-DTBR(Port0) 
 

■ RS-232C (1:1 connection) 

COM1 / COM2 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 CD 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RD 2 2 TXD 

SD 3 3 RXD 

DTR 4 4 DTR 

SG 5 5 SG 

DSR 6 6 DSR 

RTS 7 7 RTS 

CTS 8 8 CTS 

 9 9  

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 
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5.4 Cable table 4 (FBe/FBn Series – Port1/2 on CPU Unit) 
 

■ RS-232C (1:1 connection) 

COM1 / COM2 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 RXD 

 

Based on 

communication 

cable connector 

front, 

D-SUB 15 Pin male 

(male, convex) 

RD 2 2 TXD 

SD 3 3 RTS 

DTR 4 4 CTS 

SG 5 5  

DSR 6 6 SG 

RTS 7 7  

CTS 8 8  

 9 9  

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

■ RS-485 (1:1 connection) 

COM1 / COM2 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  5 D+ 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin female 

(male, convex) 

 2 7 D– 

 3  

RDB 4 

 5 

SDA 6 

 7 

 8 

SDB 9 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

■ RS-485 (1:1 connection) 

COM3 

Cable connection 

PLC 

Pin arrangement 
Signal 

name 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

+  5 D+ 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin female 

(male, convex) 

- 7 D– 

SG  

 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

■ RS-485 1 : N connection - Refer to 1:1 connection to connect in the following method. 

TOP 
Cable connection and signal 

direction 

PLC 
Cable connection and signal 

direction 

PLC 

Signal name 
Pin 

number 

Signal 

name 

Pin 

number 

Signal 

name 

RDA  5 D+  5 D+ 

RDB 7 D– 7 D– 

SDA 

 

 

SDB 

SG 
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5.5 Cable table 5 (FB Series – RS-485) 
 

■ RS-485 (1:1 connection) 

COM1 / COM2 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Signal 

name 
Pin arrangement 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  D+ 

 

Terminal Block 3 Pin 

 2 D– 

 3  

RDB 4 

 5 

SDA 6 

 7 

 8 

SDB 9 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

■ RS-485 (1:1 connection) 

COM3 

Cable connection 

PLC 

Pin arrangement 
Signal 

name 

Signal 

name 
Pin arrangement 

 

+  D+ 

 

Terminal Block 3 Pin 

- D– 

SG  

 

 

■ RS-485 1 : N connection - Refer to 1:1 connection to connect in the following method. 

TOP 
Cable connection and signal direction 

PLC Cable connection and signal 

direction 

PLC 

Signal name Signal name Signal name 

RDA  D+  D+ 

RDB D– D– 

SDA 

 

 

SDB 

SG 
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6. Supported addresses 

The devices available in TOP are as follows:  

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address 

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the 

address range supported by the device you want to use.  

 

Device Bit Address Word Address 32 Bits Remarks 

Input relay X000 ~ X255 WX000 ~ WX240 L/H  

Output relay Y000 ~ Y255 WY000 ~ WY240  

Step relay S000 ~ S999 WS000 ~ WS976  

Internal relay M0000 ~ M1911 WM0000 ~ WM1888  

Special relay M1912 ~ M2001 WM1912 ~ WM1976  

Timer(Contact) T000 ~ T255 WT000 ~ WT240  

Counter(Contact) C000 ~ C255 WC000 ~ WC240  

Timer(Current value) TMR000.00 ~ TMR255.15 TMR000 ~ TMR255  

Counter(Current value) 
CTR000.00 ~ CTR199.15 CTR000 ~ CTR199  

––––– CTR200 ~ CTR255  

Data register R00000.00 ~ R65535.15 R00000 ~ R65535  

Data register D00000.00 ~ D65535.15 D00000 ~ D65535  

 

 


